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These release notes contain system requirements for NI Circuit Design 
Suite 10.1.1, and information about product tiers, new features, 
documentation resources, and other changes since NI Multisim 10.1 
and NI Ultiboard 10.1. 

NI Circuit Design Suite includes the familiar NI Multisim and NI Ultiboard 
software products from the National Instruments Electronics Workbench 
Group. The NI Multisim MCU Module functionality is now included with 
NI Multisim. 
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Installing NI Circuit Design Suite 10.1.1
This section describes the system requirements and installation procedures 
for NI Circuit Design Suite. 

Minimum System Requirements
To run NI Circuit Design Suite 10.1.1, National Instruments recommends 
that your system meet or exceed the following requirements: 

• Windows 2000 Service Pack 3 or later, Windows XP, Vista, or 
64-bit Vista.

• Pentium 4 class microprocessor or equivalent (Pentium III class 
minimum).

• 512 MB of memory (256 MB minimum). 

• 1.5 GB of free hard disk space (1 GB minimum).



© National Instruments Corporation 3 NI Circuit Design Suite Release Notes

• Open GL® capable 3D graphics card recommended (SVGA resolution 
video adapter with 800 × 600 video resolution minimum, 1024 × 768 
or higher preferred). 

• To develop custom LabVIEW based instruments for use in Multisim, 
LabVIEW 8.2.x or 8.5.x is required. 

Installation Instructions 
The NI Circuit Design Suite 10.1.1 installer installs both products in the 
suite: NI Multisim and NI Ultiboard. 

If you have not installed version 10.1.0, the installer installs that version 
first, followed by version 10.1.1. If you have already installed version 
10.1.0, the installer installs version 10.1.1, which automatically updates 
version 10.1.0 in the same directory in which it was originally installed. 

National Instruments recommends that you close all open applications 
before you install NI Circuit Design Suite.

Unless you specify another location during installation, the NI Circuit 
Design Suite installation program copies files to <Program Files>\
National Instruments\Circuit Design Suite 10.1 after you 
complete the following steps:

1. Insert the NI Circuit Design Suite CD into the CD-ROM drive. If the 
CD startup screen is not visible, select Run from the Windows Start 
menu and run setup.exe from your CD drive. 

2. Follow the instructions in the dialog boxes. 

Note On completion of the NI Circuit Design Suite (NI CDS) 10.1.1 installation, the 
installer prompts you for the NI ELVISmx 4.0 installation CD, which is included in your 
NI CDS package. The NI ELVISmx 4.0 enables the NI ELVIS II functionality in Multisim. 
If you wish to install the NI ELVISmx 4.0 software, follow the instructions in the prompt. 
Otherwise, you can install the NI ELVISmx 4.0 software at a later time. Refer to the Virtual 
NI ELVIS II and NI ELVIS Instruments sections for more information. 

Product Activation 
When you run a product in NI Circuit Design Suite for the first time, it will 
prompt you to activate a license for that product. 

If you do not activate a valid license, the product will run in Evaluation 
Mode and continue to prompt you to activate a license on each subsequent 
run. Evaluation Mode is valid for 30 days following the first run of the 
product.
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For information about how to activate your software product, please refer 
to the Activation Instructions for National Instruments Software Note to 
Users included with your NI Circuit Design Suite package.

What’s New in NI Circuit Design Suite 10.1.1
This document describes the following feature additions or improvements 
to NI Circuit Design Suite 10.1.1: 

• Toolbars in Multisim and Ultiboard can be locked in place.

• Multisim’s component search is always advanced.

• Ability to choose units for RLC components.

• Multisim instruments and grapher allow default black or white 
background. 

• Multisim does not automatically rewire large pin-count components.

• Improved parameter suppport for semiconductor devices. 

• Added support for Cadence® PSpice® temperature parameters. 

• Improvements to SPICE DC convergence algorithms.

• New components from leading manufacturers. 

• Add All and Remove All functions added to Ultiboard’s Group Editor.

• Custom land patterns in Ultiboard automatically synchronize to 
Multisim.

• Renumbering footprints in Ultiboard includes top-to-bottom setting.

• Snap-to-pin in Ultiboard is only active during trace placement.

• Improvements to Ultiboard’s Gerber viewer. 

• Bug fixes. 

Locking Toolbars
In previous versions of Multisim and Ultiboard, the location of docked 
toolbars would sometimes change if the application was resized or closed 
while minimized. 

This has been fixed for this distribution. By default, docked toolbars are 
now locked in place. You can unlock the toolbars from the Options menu. 
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Advanced Multisim Component Search
The functionality of the Search Component dialog box, which is accessed 
by clicking Search in the Select a Component dialog box, has changed. 

The Advanced button has been removed from the dialog box—the 
Function, Model ID, Model Manufacturer, and Footprint Type fields 
are now always visible. 

Units for RLC Components
When placing resistors, inductors or capacitors (R, L, or C components) in 
Multisim with the Select a Component dialog box, you can set the value 
of these components to a numeric string with an optional metric suffix, 
for example, “k”, “n”. 

In versions 10.1.0 and prior, values entered in this way were reformatted 
without warning—for example, if you entered “2000M”, the value would 
be reformatted to “2G”. This behavior was not desirable, as manufacturers 
do not always use the most obvious metric unit to describe their 
components in price lists and specifications. For example, components with 
values of “1k” and “1000” are often from different manufacturers. 

Units are no longer converted—the value and unit displayed on the 
schematic and in reports now display as entered during component 
placement. 

Note You can also edit the value of an R, L, or C component from the Value tab of the 
component’s properties dialog box. The value remains as entered. 

Refer to the Multisim Help File for a list of the supported suffixes. 

Default Background Color for Instruments and Grapher
You can now select either black or white default background color for the 
Multisim Grapher and instruments. 

No Automatic Rewire of Large Pin-Count Components
As with previous versions of Multisim, components with a large pin count 
can be set to autowire on move from the General tab of the Preferences 
dialog box. This is done using the Autowire on move, if number of 
connections is fewer than checkbox, and its associated field. 

In past versions of Multisim, if this checkbox was disabled, or if a 
component with more than the set number of connections was moved, the 
moved component would keep the connections, but the wires would be 
drawn in straight, usually diagonal lines that were very confusing to view.
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Now, when the checkbox is disabled, or a component with more than the 
set number of connections is moved, the wires are disconnected from the 
component and remain in their original location. 

Improved Parameter Support for Semiconductor Devices
The JFET, MESFET, MOSFET (level 1, 2, and 3) and BJT semiconductor 
models have been updated to support additional model parameters.  

The new parameters descibe temperature, DC, small signal, and noise 
characteristics of the semiconductor devices. They are: 

• JFET: 

– ALPHA, BETATCE, ISR, M, N, NR, PB, VK, VTOTC, XTI.

• BJT: 

– CN, D, GAMMA, ISS, NS, QCO, QUASIMOD, RCO, TRB1, 
TRB2, TRC1, TRC2, TRE1, TRE2, TRM1, TRM2, VG, VO, 
XCJC2, XCJS.

• MOSFET: 

– GDSNOI, JSSW, N, NLEV, PBSW, TT, WB, XQC.

• MESFET: 

– BETATCE, CDS, EG, N, RG, TRD1, TRG1, TRS1, VTOTC, 
XTI, M, TAU, VDELTA, VMAX.

The BJT devices now also support lateral PNP (LPNP) models. 

Refer to the Multisim SPICE Reference section of the Multisim Help File 
for complete information. 

Added Support for Cadence® PSpice® Temperature Parameters
Support for T_MEASURED, T_ABS, T_REL_GLOBAL and 
T_REL_LOCAL Cadence® PSpice® temperature parameters has been 
added to: Resistor, Capacitor, Inductor, Diode, JFET, MESFET, MOSFET 
(level 1, 2, and 3) and BJT devices. 

Refer to the Multisim SPICE Reference section of the Multisim Help File 
for complete information. 
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Improvements to SPICE DC Convergence Algorithms
Dynamic source-stepping and GMIN-stepping algorithms have been added 
to DC Operating Point calculations. These are used when ordinary 
algorithms fail to converge. 

Refer to the DC Convergence Assistance Algorithms section of the 
Multisim Help File for more information.

New Components from Leading Manufacturers
There are 316 new components from Analog Devices and National 
Semiconductor in Multisim. The additions include symbols, models, and 
land patterns.  The components are comprised of operational amplifiers, 
comparators, and RMS-to-DC Converters. 

There are also 232 updated components from Analog Devices and National 
Semiconductor.  These components have been updated to contain the latest 
models and package information. 

In Ultiboard, there are 35 new land patterns for National Semiconductor 
packages.

Add All and Remove All Added to Ultiboard’s Group Editor
The ability to add all and remove all parts or nets from a group has been 
added to Ultiboard’s Group Editor. 

Note Whether parts or nets are being added to, or removed from, a group depends on the 
tab selected in the Edit Groups dialog box. Refer to the Ultiboard Help File for complete 
information. 

Custom Land Patterns in Ultiboard Automatically Synchronize to 
Multisim

When you create or edit a part with a custom land pattern (footprint) in 
Ultiboard, the change is now automatically synchronized in Multisim. This 
appears in the preview field of the Select a Footprint dialog box in 
Multisim. 

Note If the database containing the part is already open in the Select a Footprint dialog 
box in Multisim when you create or edit the part in Ultiboard, you must select a different 
database and then reselect the original database to view the change. 
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Renumbering Parts in Ultiboard
The renumbering parts functionality has changed to allow footprints on 
PCBs to be renumbered by:

• Board side order.

• Renumbering direction and renumbering start location by board side.

Snap-to-Pin is Only Active During Trace Placement
Ultiboard has been modified so that “snap-to-pin” behavior is now only 
active during trace placement. This allows easier selection of non-pin 
elements during any other operation. 

Improvements to Ultiboard’s Gerber Viewer
Gerber files generated by other applications can now be viewed in 
Ultiboard. Refer to the Ultiboard Help File for more information. 

Note Mathematical expressions are not supported. 

Bug Fixes
Refer to the Readme file at <Program Files>\National 
Instruments\Circuit Design Suite 10.1\documentation 
for a list of bugs in version 10.1.1: 

• Readme_eng.html—English Readme file

• Readme_deu.html—German Readme file

• Readme_jpn.html—Japanese Readme file

What’s New in NI Circuit Design Suite 10.1
This document describes the following feature additions or improvements 
to NI Circuit Design Suite 10.1:

• The Multisim Automation API

• Virtual NI ELVIS II

• NI ELVIS instruments.

• Enhancements to NI LabVIEW instruments in Multisim

• Additions to the component database

• Extended SPICE modeling capabilities

• NI Update Service

• Vista compliance
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• Support for TDMS data files

• File compatibility with NI Circuit Design Suite 10.0.x

• New font rendering in NI Ultiboard

The NI Multisim Automation API
The NI Multisim Automation API allows the automation of simulation and 
analyses through a COM interface. This is useful when a number of 
simulation runs are required with different circuit settings. Examples 
include such tasks as component analysis, stress analysis, and fault 
analysis. 

The Multisim Automation API lets you programmatically control a 
Multisim simulation without needing to view Multisim. Clients written 
in any COM-aware programming language, such as NI LabVIEW, 
Visual Basic, or C++ can access Multisim through this interface. 

Through the API, you can:

• Open and close an existing circuit.

• Optionally inject a signal in place of an existing voltage or current 
source.

• Start, stop, and pause simulations.

• Read out simulation results from an existing static probe.

• Enumerate the components in the schematic.

• Replace components with components from the database.

• Get and set the values of resistor, capacitor, and inductor components.

• Enumerate variants.

• Get and set the active variant for simulation.

• Generate reports on the schematic, including a bill of materials and 
a netlist report.

• Produce an image of the circuit.

Notes Simulation settings used during API control simulations are taken from the 
Transient Analysis settings of the chosen circuit. Any changes to the Interactive Simulation 
settings are ignored. 

The API can only change and replace components on the top level of a design; components 
in sub-circuits and hierarchical blocks cannot be altered. 

Multisim component replacements may not always have the expected result—they should 
always be tested in an interactive session of Multisim to make sure that the behavior is what 
is required. 
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Multisim Fault settings cannot be changed through the API. Fault analysis requires the 
building of circuits with additional resistive elements and setting the elements to zero or 
large values. 

Virtual NI ELVIS II
NI Multisim 10.1 includes new functionality to complement the 
introduction of the NI ELVIS II. The Virtual NI ELVIS II builds on the 
functionality of the Virtual NI ELVIS found in previous releases of the 
software. NI ELVIS II functionality is activated in Multisim after you 
install the NI ELVISmx 4.0 software. You can now choose to start from 
either a new NI ELVIS or NI ELVIS II schematic. The selection of 
schematic template will affect which of the 3D NI ELVIS models is used 
in the breadboard mode. Select File»New»NI ELVIS II to select the 
NI ELVIS II template. 

In addition to the new schematic template and new 3D model, NI Multisim 
now leverages the NI ELVISmx 4.0 Soft Front Panels (SFP) inside of 
Multisim. 

Note that NI ELVIS II refers to the hardware revision number and 
NI ELVISmx 4.0 refers to the software revision. 

Note To take full advantage of the integration of NI ELVIS II and Multisim, you must also 
install the NI ELVISmx 4.0 software. 

NI ELVIS Instruments
In previous releases, native Multisim instruments were used to replicate 
the types of measurements performed with the real world NI ELVIS. 
NI Multisim now hosts the NI ELVIS II Soft Front Panels (SFP) used with 
the instrument hardware. These instruments allow you to show both 
simulated and real measured data on the same display. 

There are two ways to invoke an NI ELVIS II SFP: you can access them 
from either the rails or the top of an NI ELVIS II schematic template, or 
you can drop them onto any Multisim schematic from the NI ELVIS 
Instruments toolbar. 

Limitations of NI ELVIS II in Multisim 10.1
Multisim does not support all of the NI ELVIS 4.0 SFPs in the 10.1 release.  
Instruments that provide frequency response information, such as the Bode 
Analyzer, and those that provide impedance and current measurements are 
not supported. 
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Enhancements to NI LabVIEW Instruments in NI Multisim
LabVIEW instruments in Multisim let you create custom input, output, 
and input/output instruments for use in Multisim. Improvements in 
Multisim 10.1 include support for both input and output pins on the same 
instrument, continuous data out to Multisim from output instruments, and 
the ability for input instruments to affect the time step and interpolation 
method used in simulation.

Input and Output Instruments
Previous releases allowed input-only and output-only instruments. 
Input/output instruments have all of the capabilities of input-only and 
output-only instruments. Note, however, that LabVIEW instrument input 
data is lagging (meaning that it arrives at the instrument in discrete chunks 
after the simulator has produced the data), and streaming-out data is leading 
(meaning that the simulator requests the data in discrete chunks before 
it needs it). This means that tight feedback loops where a LabVIEW 
instrument’s output depends instantaneously on its intput are not possible. 
In general, it will take at least one extra set of continuous outputs through 
the “Update Data Get Output Values” event of the instrument before you 
can be sure that the input received by that instrument reflects an adjusted 
output signal. 

Continuous Data from Output Instruments
Previously, data output instruments could generate a finite set of possibly 
repeating data. When creating an output instrument that generates data 
continously, remember that, in general, Multisim simulates circuits at a rate 
slower than the real-time behavior of an equivalent physical circuit. 
Therefore, if you create an instrument that continuously acquires 
real-world data using a data acquisition device, modular instrument, or 
other similar hardware, and use that data as a simulation source in 
Multisim, simulation will not be able to keep up with the acquired data 
because it will be running at a rate slower than the data acquisition. 

It is the responsibility of the output instrument creator to generate 
sufficiently small chunks of data at a rate that allows Multisim simulation 
to keep up with the data acquisition.
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Affecting the Time Step and Interpolation Method
LabVIEW samples and processes data at even time steps. SPICE generally 
operates at uneven time steps best suited to convergance and speed. When 
creating an input instrument, it is neccesary to resample the data to evenly 
spaced data for use in LabVIEW. You can now create an instrument that 
uses Force Step interpolation. (Force Step is not strictly an interpolation 
method. It forces the Multisim SPICE simulator to take additional 
timesteps that line up with the requested sampling rate.)

If a particular LabVIEW instrument allows you to set the sampling rate 
and/or interpolation method, Multisim 10.1 recognizes changes to these 
values during simulation. 

Increased Quality and Breadth of the Component Database
Multisim 10.1 includes new additions and improvements to the database. 
These include around 300 new components from leading manufacturers, 
more than 500 updated components, and the latest generic power 
simulation parts. 

New Components from Leading Manufacturers
There are around 300 new components with models from Analog Devices 
and Texas Instruments. The additions include symbols, models, and IPC 
compliant land patterns. These components include operational-amplifier, 
comparator, analog switch, and voltage reference models.

Generic Power Simulation Parts
Multisim 10.1 includes models for all freely available power simulation 
parts found in the latest release of “Switch-Mode Power Supplies Spice 
Simulations and Practical Designs” by Christophe Basso. These 
components include Buck, Boost, Buck-Boost, and PWM controllers.

Extended SPICE Modeling Capabilities
Multisim 10.1 introduces enhancements to its SPICE modeling 
capabilities. The SPICE parser has been redesigned and improved to better 
support multiple SPICE languages and advanced modeling. Multisim also 
supports more Cadence® PSpice® parameters. There is also improved 
XSPICE model error reporting.
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Redesign and Improvement of the NI Multisim SPICE
Parser
The SPICE parser in Multisim interprets the native SPICE net lists, reports 
syntax errors, and evaluates mathematical expressions. Enhancements to 
the parser include:

• Improved syntax and simulation compatibility for controlled sources.

• Table sources.

• Numerous compatibility improvements that enhance the ability to 
support Cadence® PSpice® and Intusoft IsSpice4™ syntax.

• Flexible component, net, terminal, and model names.

– Names may contain any characters with the exception of white 
space and the following characters: " ' ( ) { } [ ] , # $: ;

• The ability to use expressions in place of any value in the netlist.

– The two special exceptions to this are the BSIM level param and 
the POLY number in a controlled source. 

• Improved support for expressions, including:

– Support of inline if statements.

– Improved support for .param statements.

– Full support of single and nested .func statements.

– Current through diodes and relevant controlled sources can now 
be used in expressions (for arbitrary sources).

– Improved convergence for complex behavioral-modeling style 
circuits.

Improved SPICE Model Error Reporting
More intelligent error messages are presented for errors relating to SPICE 
models. 

Component terminals, parameters and expressions are now checked in 
depth before the simulation begins. Simulation errors display in the 
Simulation tab of the Spreadsheet View and identify the Multisim 
components that are causing the issue. 

Note With the exception of the Simulation tab and the Results tab, the Spreadsheet View 
is not available in the Student edition of Multisim. Refer to the Multisim Help File for 
information about these tabs. 
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Improvements to Cadence® PSpice® Compatibility
Multisim 10.1 now supports the following Cadence® PSpice® parameters 
for MOSFETS and BJTs: 

NI Update Service
The new NI Update Service helps keep your National Instruments software 
and drivers up-to-date. NI Update Service, which replaces the existing 
Support and Upgrade Utility (SUU), checks for and electronically delivers 
software updates for your NI software. You can launch NI Update Service 
at any time to check for updates or determine the most recent time updates 
were installed. 

Windows Vista Compliant
NI Circuit Design 10.1 is Windows Vista Compliant. Version 10.0.1 was 
Vista compatible but continued to write to the Program Files directory 
during run-time. Multisim 10.1 follows Vista Compliance Guidelines.

Better Storage of User Fields from the Master 
Database
User fields associated with components stored in the Master database are 
now stored separately. You will see no visible impact when editing and 
working with user fields in Multisim. This will, however, help to preserve 
data as you migrate from version to version. This is also required for Vista 
compliance.

Support of TDMS Data Files
Multisim now supports TDMS files. TDM voltage and current sources can 
reference TDM streaming data files and the Multisim Grapher can export 
TDMS data.

Parameter Description Device

m Device multiplicity parameter MOSFET

Rg, Rb Gate and Bulk Ohmic Resistance MOSFET

Rds Drain-Source Shunt Resistance MOSFET

W, L Width and Length support on 
.model line

MOSFET

Nk Knee current roll-off coefficient BJT
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Files are Compatible with NI Circuit Design Suite 10.0.x
Files from NI Circuit Design Suite 10.0.x and 10.1 are backward and 
forward compatible. File extensions remain the same; files saved with 
either version will open in both versions.

New Font Rendering in NI Ultiboard
Fonts placed on layers on the board in Ultiboard are now drawn using 
anti-grain geometry. This provides faster font rendering and better 
anti-aliasing. 

Localization
NI Circuit Design Suite 10.1 is localized for English, German, and 
Japanese. The system locale setting determines the default language 
used by the software. 

To change the default language the software uses, select Options»Global 
Preferences, click on the General tab, select the desired locale from the 
Language combination box, and restart the application. 

The following items are not localized, and remain in English: 

• LabVIEW instruments

• NI ELVIS instruments

• Layer names in both NI Ultiboard and the NI Multisim 
Spreadsheet View

• Agilent and Tektronix simulated instruments

• Sample files

• MCU functionality: source file names, code/comments within source 
files, and compiler/linker messages

The following documentation is available in English, German, and 
Japanese:

• Release Notes

• Getting Started with NI Circuit Design Suite

User manuals and help files are not localized, and remain in English. 
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Product Tier Details
The following lists the schematic capture functionality available in 
Multisim Student and Education editions:

Functionality Student Education

Customizable GUI X X

Screen-capture utility X X

Comments on schematic X X

Circuit annotations X X

Modeless part placement and wiring X X

Fast retrieval parts bins X X

Auto and manual wiring X X

Virtual wiring by node name X X

Rubber banding on part move X X

Fast auto-connect passives X X

Subcircuits X X

3-dimensional breadboarding X X

Virtual NI ELVIS I and II X X

Embedded questions—view 
and respond

X X

Forward/Back annotation 
with Ultiboard

X X

Cross-probing with Ultiboard X X

Bus-vector connect X

Spreadsheet view X

Design constraints X

Advanced search X

Zoom to selected part X

Corporate database X

User defined fields X
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The following lists the simulation functionality available in Multisim 
Student and Education editions:

Save components to database from 
workspace

X

Multiple circuits open X

Embedded questions—create and edit X

Electrical rules check X

Graphically mark no-connect pins X

Hierarchical designs X

Multisheet designs X

Project manager X

Reports—including bill of materials X

Pin and gate swap X

Export to Mentor PADS layout X

Device library Partial Complete

Maximum components in design 50 Unlimited

Functionality Student Education

Interactive simulation X X

Fully mixed-mode A/D simulation X X

Standard SPICE 3X5/XSPICE X X

Enhanced model support X X

Cadence® Pspice® model simulation* X X

Speed/Accuracy tradeoffs X X

Simulation advisor X X

Convergence assistant X X

Virtual, interactive, animated parts X X

Mouse click support for interactive 
parts

X X

Functionality Student Education
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Rated components X X

Insert faults into components X X

Measurement Probes X X

Component Wizard X X

NI measurement data file sources X X

NI measurement data file export X X

NI LabVIEW VIs as instruments 
and sources

X X

Microphone & speaker X X

Circuit restrictions X X

Grapher & Postprocessor X X

RF design kit X X

Circuit wizards X

C-Code modeling X

Description box synced 
with simulation

X

Ladder diagrams/components X

Model makers X

Load and save simulation profiles X

Virtual Instruments 22 22

Analyses 10 18

Multisim MCU X X

Multisim Automation API X

* Does not support all Cadence® PSpice® syntax

Functionality Student Education
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The following lists the layout functionality available in Ultiboard Student 
and Education editions:

Functionality Student Education

Push and Shove trace placement X X

Push and Shove part placement X X

Real-time & from copper ratsnest X X

Real-time polygon update with 
voiding

X X

Forward/Backward annotation X X

Cross-probing with Multisim X X

Real-time DRC X X

64 layers and 1 nanometer resolution X X

Comprehensive Footprint Wizard X X

Enhanced 3D visualization with print X X

User annotations X X

Full  screen mode X

Gerber, DXF, IPC-D-356A, 
SVG output

X

Dimensions on PCB and Landpatterns X

Dimensions in Database Manager X

Net bridges X

3D visualization inside circuit board X

Turn off ratsnest for selected nets X

Gridless follow-me placement X

Load and save technology files X

Polar Grids X

Customizable layer viewing X

Split power-planes X

Keep-in/Keep-out areas X

Place components in array X
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Unplace all components X

Ruler bar alignments and 
measurements

X

Auto-alignment X

Save PCB Design as a component X

Permanent grouping X

Pin & gate swapping X

Multiple clearances X

Jump to Error X

Equispace trace support X

Differential Impedance Calculator X

Transmission Line Calculator X

Microvias X

Test point insertion X

Automatic tear-dropping X

Pin necked trace support X

Automatic jumper insertion X

Copy Route & Replica Place 
functions

X

In-place footprint editor X

Mechanical CAD X

Export 3D info in 3D IGES, 
DXF formats

X

Copper amount report X

Test point report X

Customization of report generation X

Multiple open documents X

Number of pins supported 350 1,000

Spreadsheet view Limited Complete

Functionality Student Education
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The following lists the autorouting functionality available in Ultiboard 
Student and Education editions:

Documentation
NI Circuit Design Suite 10.1 includes a complete documentation set 
featuring printed and electronic resources for your reference.

The following printed and electronic resources are available:

• Getting Started with NI Circuit Design Suite

• NI Circuit Design Suite Release Notes

The following electronic resources are available in PDF files:

• Multisim User Manual

• Multisim for Education Manual

• Ultiboard User Manual

Note Because the NI Multisim MCU Module functionality is now included with 
NI Multisim, the Multisim MCU Module User Guide has been discontinued. Refer to the 
Multisim User Manual for information about Multisim MCU. The Multisim Component 
Reference Guide has been discontinued. Refer to the Component Reference Help File for 
information about components. 

Functionality Student Education

Fully customizable cost factors X X

Progressive Routing X X

Interactive autorouting X X

Constraint driven routing X X

Manual pre-placement: components, 
vias, traces

X X

Auto Block Capacitor recognition X X

SMD mirroring X X

Trace rubberbanding X X

Follows keep-in/keep-out criteria X X

Pin number limit 350 1,000

Maximum number of layers 2 4
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To access the User Manuals, select Start»All Programs»National 
Instruments»Circuit Design Suite 10.1»Documentation and then select 
the file of interest.

The following online help files are available from the installed software 
Help menu and from the Start Menu: 

• Multisim Education Edition Help File

• Ultiboard Help File

To access the Help Files, from the Start menu, select Start»
All Programs»National Instruments»Circuit Design Suite 10.1»
Documentation and then select the file of interest. 

The following online help files are available from the installed software 
Help menu: 

• Component Reference Education Edition Help File

• Multisim Symbol Editor Help File (access from the Symbol Editor)

• Multisim Title Block Editor Help File (access from the Title Block 
Editor) 
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